
DynaTool Help Index

Description of DynaTool Program history

User manual and help data base Release Notes

Theory manual Known bugs and failings

Verification manual Wish list

Programming today is a race between software engineers
striving to build bigger and better idiot proof programs, and
the Universe trying to produce bigger and better idiots.    So

far, the Universe is winning. --- R. Cook



Commands
File menu
Edit menu
Array menu
Tools menu
View menu
Plot menu
Window menu
Help menu



File menu commands
The File menu offers the following commands:

New Creates a new DynaTool document.
Open Opens an existing DynaTool document.
Close Closes an opened DynaTool document.
Save Saves an opened DynaTool document using the same file name.
Save As Saves an opened DynaTool document to a specified file name.
Export Exports arrays as formatted text files
Print Prints a document.
Print Preview Displays the document on the screen as it would appear printed.
Print Setup Selects a printer and printer connection and paper size.
Exit Exits DynaTool.



Edit menu commands
The Edit menu offers the following commands:

Edit Response Spectrum Edit response spectrum array parameters
Edit Time History Edit time history array parameters



Array menu commands
The array menu contains the following commands:

New Create a new array
Delete Delete an array
Rename Rename an array



Tools menu commands
The array menu contains the following commands:

Fill Table Fill an array
Time History Generate time histories
Response Spectrum Generate response spectra
Fourier Calculate Fourier coefficients
Integration/Differentiation Integrate or differentiate arrays
Algebra Carry out algebraic calculations on and between arrays, 

including mathematical functions
Setup Program set-up sub menu



Setup menu (Tools menu)
The tools->setup menu contains the following commands:

Time History Set parameters for time history generation
Response Spectrum Set parameters for response spectrum generation



View menu commands
The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Plot menu commands
The View menu offers the following commands:

Define Plot Creates and edits plot definitions.
View Plot Selects a defined plot for display. 
Appearance Sets appearance attributes for the plot. 
Show Attributes Sets display attributes. 
Font Sets the fonts to be used on the plot. 

Window menu commands
The Window menu offers the following commands, which enable you to arrange multiple views of multiple
documents in the application window:

New Window Creates a new window that views the same document.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 2, ... Goes to specified window.



Help menu commands
The Help menu offers the following commands, which provide you assistance with this application: 

DynaTool     
Help

Offers you an index to topics on which you can get help.

Using 
Help

Provides general instructions on using help.

About Displays version information for DynaTool, including the difference 
between "free ware" and "fully supported".



New command (File menu)
Use this command to create a new document in DynaTool.

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)
Use this command to open an existing document in a new window.    You can open multiple documents at 
once.    Use the Window menu to switch among the multiple open documents.    See Window 1, 2, ... 
command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialogue box
The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type
Select the type of file you want to open:
DynaTool files have the extension .dnt

Drives
Select the drive in which DynaTool stores the file that you want to open. 

Directories
Select the directory in which DynaTool stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)
Use this command to close all windows containing the active document.    DynaTool suggests that you 
save changes to your document before you close it.    If you close a document without saving, you lose all 
changes made since the last time you saved it.    Before closing an untitled document, DynaTool displays 
the Save As dialogue box and suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown below:



Save command (File menu)
Use this command to save the active document to its current name and directory.    When you save a 
document for the first time, DynaTool displays the Save As dialogue box so you can name your document.
If you want to change the name and directory of an existing document before you save it, choose the 
Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S

              Note:    In DynaTool the file-save toolbar button and the file-save menu item are active only when 
the data has changed since the last save or since the file was read from disc.



Save As command (File menu)
Use this command to save and name the active document.    DynaTool displays the Save As dialogue box 
so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialogue box
The following options allow you to specify the name and location of the file you're about to save:
File Name

Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    DynaTool adds the extension you specify in 
the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



File Export Command (File menu)
Use this command to export data from arrays in an ASCII format which will allow the data to be imported 
into other programs including spreadsheets, finite element analysis systems and other engineering 
analysis tools.    DynaTool opens the File Export dialogue box



File Export Dialogue Box
This dialogue box enables the export of data from DynaTool arrays in a standard ASCII text format using 
a space, comma or tab separator.

The Export dialogue box consists of two list boxes, the list of filled arrays and an output list.    The list of 
available arrays consists only of those which are filled, it does not differentiate by type.    The export list 
shows the order in which arrays will be exported.    To nominate arrays for export, highlight them using the
mouse.    Once arrays have been highlighted, the >> Add >> button will activate.    Pressing the button 
adds the array names to the export list.    To export an array more than once, add its name to the list the 
required number of times.

The list of array names in the export list should be in the order in which they are required for the export 
operation.    If one or more of the items in the export list are highlighted, the names can be deleted.    This 
does not actually delete the arrays from the data base.    If a single name is highlighted and there is more 
than one name in the list, then the Move up and/or Move down buttons activate as available.

Once arrays have been listed for export, two other buttons activate, the Filename button and the Format 
button.    When a file has been nominated for the save, its pathname is displayed at the top of the 
dialogue box.

Only when the export list contains one or more array names and a filename has been nominated and a 
format has been set does the OK button activate.    Pressing OK exports the data.



File Export Format
The File Export Format dialogue defines the layout of the file.    The dialogue has four panes, 3 for input 
and one to indicate the file layout.

File Type

Select the text file type from the radio buttons, comma separated variable, space separated variable or 
tab separated variable.    Only one file type can be selected.    CSV is useful for spreadsheets and data 
bases, TAB for word processors, especially if the data is to be tabulated.

File Layout

The data can be set on the file in one of seven pre-defined layouts.

1. a1x    a1y    a2x    a2y    a3x    a3y - Writes array data in columns in x, y format.    This allows the 
exporting of data with different x sequences.
2. a1x    a1y a2y a3y - Writes array data in columns with the x data from the first array in the first 
column, then the y data from all arrays in sequence following.
3. x, y blocks - Writes array data in rows as x, y pairs.    Writes all pairs, one to a row for the first 
array, then repeats for each subsequent array.
4. x block, y block, x block, y block - Writes array data as one entry per row, writes all the x data 
for the first array, then all the y data for the first array, then repeats the sequence for each subsequent 
array.
5. x block followed by y blocks - Writes array data as one entry per row, writes all the x data for 
the first array, then all the y data for the first array, then repeats with the y data for each subsequent array.
6. x blocks followed by y blocks - Writes array data as one entry per row, writes all the x data for 
each array in turn, then all the y data in each array.
7. Y blocks only - Writes only the y array data as one entry per row, writes all the y data for each 
array in turn.

Headers

The headers option controls additional data to be written to the file.    By default the headers are applied, 
they can be switched off by checking the check boxes.

No File QA Header switches off the addition of a header to the top of the file which indicates the 
DynaTool version used to write the file, the file name and the date written.

No Block/Column Headings switches off the column headings which are written at the beginning of 
each block of data.    This information is useful when the data is read into a spreadsheet or word 
processor file to provide indications of the column content.

File Layout Sample

This area of the dialogue gives a simple clue as to the layout to be expected on the file.



Comma Separated Variable File
Data fields are separated by commas, two consecutive commas will indicate a default value, usually zero. 
The usual file name extension is .csv, although any other extension is permitted by DynaTool.

1.234, 56.0,, 10, , 34



Space Separated Variable File
Data fields are separated by one or more spaces.    Consecutive spaces are treated as single spaces.    
The usual file name extension is .txt, although any other extension is permitted by DynaTool.

1.234 56.0    10    34



Tab Separated Variable File
Data fields are separated by tabs, two consecutive commas will indicate a default value, usually zero.    
The usual file name extension is .txt, although any other extension is permitted by DynaTool.

1.234 56.0 10 34



1, 2, 3, 4 command (File menu)
Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you 
closed.    Choose the number that corresponds with the document you want to open.



Exit command (File menu)
Use this command to end your DynaTool session.    You can also use the Close command on the 
application Control menu.    DynaTool prompts you to save documents with un-saved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Edit Response Spectrum (Edit Menu)
Use this dialogue to change the properties of response spectrum arrays.

The array to be modified is selected from the drop down list.    The list will only contain arrays which have 
been flagged as being response spectra.

The damping value can be altered using the edit box.
The response spectrum type and the response type can be changed using the radio buttons.



New Array command (Array menu)
Use this dialogue to create a new DynaTool array.    Arrays are created empty, and are given an initial 
sequential unique name, which can be overwritten.

Toolbar: 

Array Type

The default array type is a standard array.    The array can be defined as a response spectrum or as a 
time history.

Motion Definition

If the array type is defined as a time history or a response spectrum, the motion definition radio buttons 
will be activated.    Select the necessary type.

Array Name

In DynaTool arrays are identified by their name.    When the dialogue opens, the array is automatically 
assigned a name, which is made unique using a sequential number.    Array names MUST be unique, and 
the dialogue forces this.    There is no restriction on characters used, spaces are legal, therefore, the 
name can be a description.    There are some reserved characters which should be used with care.    
These characters are used by DynaTool as tags to enable generated data to be uniquely named.

Fill Array Now

Arrays are created empty, if this box is checked then the Fill Table is activated when the OK button is 
pressed.



Delete Array command (Array menu)
Only active if arrays exist.

This command will delete the array selected from the drop down menu.    A confirmation box is presented 
before actual deletion takes place.

Deleting an array releases all resources and adjusts the linking of the array list.    Recovery is not 
available.



Rename Array command (Array menu)
Only active if arrays exist.

This command will rename an array.    Array names MUST be unique, and the dialogue forces this.    
There is no restriction on characters used, spaces are legal, therefore, the name can be a description.    
There are some reserved characters which should be used with care.    These characters are used by 
DynaTool as tags to enable generated data to be uniquely named.



Standard Array Type
A standard array is defined as having X and Y data (abscissa and ordinate), but with no special 
properties.



Response Spectrum Array Type
A response spectrum array is defined as having the special properties of a response spectrum.    In 
particular this is a damping property and a motion type, Acceleration, Velocity or Displacement.



Time History Array Type
A time history array is defined as having the special properties of a time history.    In particular this is a 
motion type, Acceleration, Velocity or Displacement.



Reserved Characters
Certain characters and character combinations are used by DynaTool for identification of internally 
defined tables, and as the result of generated data such as time histories or response spectra.

< ... > The < and > characters are used to delimit textual tags.    Take care if they are used in the 
combination    indicated.



Fill Table (Tools menu)
Only active if arrays exist.

The fill dialogue enables the filling or refilling of arrays.

Toolbar: 

Array Name

Select the array to be filled from the drop down list.    The list will contain the names of all defined arrays 
to allow re-filling.    Arrays can also be filled as the result of operations in the calculation module.    The 
calculation module will allow more complex array fills, however, there must be at least one filled array for 
this to be active.

X Data

Filling for the X (abscissa) data.    The X array can be filled using one of several functions:

File Read X data from an ASCII disc file.    (file reading formats)
Linear The X data is a linear progression with a starting value, a constant 

increment, a final value and a number of terms.    The program requires one 
of the following:
interval, start value, end value
start value, end value, number of items
interval, start value, end value, number of terms

Log The X data is a log progression with a starting value, a final value and a 
number of terms.

Exponential The X data is an exponential progression with a starting value, a final value 
and a number of terms.

Log10 The X data is a log base 10 progression with a starting value, a final value 
and a number of terms.

10 Power The X data is a power 10 progression with a starting value, a final value and
a number of terms.

List The X data is to be input by hand.

The fill functions fill the X data with the prescribed number of terms, including the start and finish values, 
with a constant increment based on the function. 

X Array Fill Data

This area of the dialogue is only activated for those fill functions which require it,    It is not activated for file
and list options.

The X Interval option is only active for the linear fill option.

Y Data

Filling for the Y (ordinate) data.    The Y array can be filled using one of several functions:

File Read Y data from an ASCII disc file.    (file reading 
formats)

y = mx + c The Y data is generated from a linear equation.
y = k.log(x) + c The Y data is calculated based on the log of the X value.



y = k.log10(x) + c The Y data is calculated based on the log base 10 of the 
X value.

y = k.exp(x) + c The Y data is calculated based on e power X value.
y = k.10**x + c The Y data is calculated based on 10 power X value
Enter as list The Y data is to be input by hand.
Random Value The Y value is entered as a random number.
Asin(kx + P)                ... (radians) The Y value is filled based on the sine of the X value.
Asin(Pi(kx + P))      ... (radians) The Y value is filled based on the sine of the X value.

Y Array Fill Data

This area of the dialogue is only activated for those functions which require it,    It is not activated for file 
and list options.

The edit boxes are activated and labelled to identify the expected contents.    There are no default values.

X & Y Data From The Same File

If both the X and Y data is indicated as being from a disc file, this check box is activated.    If it is checked, 
then both arrays are read from the same file.    (file reading formats)



Time History Generation (Tools menu)
Only active if filled response spectrum array(s) exist

This dialogue sets up and activates the time history generation.

Toolbar: 

Time History Array

Use this drop down list to identify which array to use to store the generated time history.    If a suite of time
histories is to be generated, then this name becomes the base name.    The drop down list will only 
contain arrays flagged as being time history arrays.

If you want to create a new array for the target, select the [New Array] item.    This will activate the new 
array dialogue before generation begins.

Target Response Spectrum

This drop down will contain a list of all of the defined and filled response spectrum arrays.    The selected 
response spectrum is chosen as the target response spectrum for the generated time histories.    A target 
response spectrum MUST be declared.

Time Envelope

This area of the dialogue defines the time history duration and the rise and decay times.    The method of 
defining the envelope is selected using the radio buttons.

The Define Envelope option allows an envelope with a linear rise and decay.    The duration gives the 
overall length of the time history.    If the combined rise and decay times exceed the time history duration, 
then an error is flagged.

The Array Envelope option allows a more complex envelope to be defined in an array.    The drop down 
list will display all the available standard arrays.

Iteration Control

Time Step sets the time step for the time history time interval, this is a constant value.

Iteration Limit sets the number of iterations to be used in the time history calculation.



Time History Features
This is a sub dialogue which sets various features for the time histories.

This dialogue consists of a set of check boxes to activate options.

Baseline Correction applies a correction to the generated time history to ensure that the displacement 
finishes at (or very close to) zero.

ASCE 4-86 Compatibility makes the frequency content of the time history comply with the requirements 
of ASCE 4-86.

NUREG 008 Compatibility makes the frequency content of the time history comply with the requirements
of NUREG 008.

Note:
To generate time histories outside the seismic range, or to generate time histories which do not 
necessarily need to comply with NUREG 008 or ASCE 4-86 BOTH of these options should be switched 
off.

Random Phase Angle this applies a randomly generated phase angle to the sine wave components of 
the time history.    If this option is checked a seed can be entered in the seed box.    If the seed is 0, then 
the seed for the random number generator is taken from the system clock.    Any other seed is taken as a 
fixed seed, enabling repeatable calculation.

Generate Time History Set enables the generation of time history sets from the defined target response 
spectrum.    If this option is selected, then the random phase angle should also be set to allow the time 
histories generated to differ from each other.

If the 2 Horizontal 1 Vertical option is chosen, then a suite of three time histories are generated with the 
vertical data internally scaled by 2/3.    Otherwise, enter a number in the Generate Set of edit box.

Note:    testing has shown that sets generated with the random phase angle are statistically independent.



Response Spectrum (Tools menu)
Only active if filled time histories exist

Toolbar: 

Response Spectrum Array

Use this drop down list to identify which array to use to store the generated response spectrum.    The 
drop down list will only contain arrays flagged as being response spectrum arrays.

If you want to create a new array for the target, select the [New Array] item.    This will activate the new 
array dialogue before generation begins.

Response Spectrum Type

These radio buttons select the type of response spectrum to be generated.

Amplitude

Should the response be calculated from the absolute amplitude of the single degree of freedom oscillator, 
or from its amplitude relative to the input.

Time History Array

A drop down list of time history arrays from which to generate the response spectrum.



Fourier (Tools menu)
Original Array

This drop down list contains all arrays available for transformation into the domain selected with the 
domain radio button.    The list changes and only includes candidate arrays.

The title of the calculation attributes box changes with function.    If the translation is to the frequency 
domain then the tile is xxxx Input Array Time History Points, where xxxx is the number of points in the 
input array.

The transform is carried out using a Fast Fourier Transform algorithm, therefore, the input and output 
array lengths need to be powers of two.    The Output Array Frequency Points drop down box will list 
three lengths, one shorter than the input, and two longer than the input.    Select the required length.

Fourier Spectrum Smoothing Window this is the size of the window over which the Fourier coefficients 
are averaged when plotting the Fourier spectrum.

If the translation is to the Time Domain then the region is titled Input Array Fourier Frequency.    The 
only box to be filled is the time step for the output time history.

Output Array

Use this drop down list to identify which array to use to store the generated Fourier data.    The drop down
list will only contain arrays flagged as being of the type relating to the required output domain.

If you want to create a new array for the target, select the [New Array] item.    This will activate the new 
array dialogue before generation begins.



Integration/Differentiation (Tools menu)
Only active if filled arrays exist

Input Array

This drop down list contains a list of all available arrays.

Output Array

This drop down list contains a list of all arrays available to take the output, including that chosen for the 
input.    The input an output can be the same.

If you want to create a new array for the target, select the [New Array] item.    This will activate the new 
array dialogue before generation begins.

Integration Constant

A constant used as the initial value for the integration.

Integrate - button to execute integration.

Differentiate - button to execute differentiation.

Work in Frequency Domain check box is activated if the input array is a response spectrum.    This 
allows the integration/differentiation to be carried out in the frequency domain.



Algebra (Tools menu)
Only active if filled arrays exist

Toolbar: 

Array Calculation Dialogue

This dialogue allows algebraic calculation on and between arrays.    The idea is to build a function in the 
calculation window, which will be executed when the OK button is pressed.    The syntax of the function is 
described later.    (Syntax).    The expression can be typed directly into the edit window by using the 
keyboard, data can be added using the calculator style keys in the dialogue, or a combination of both.    
Syntax checking occurs when OK is selected, or it can be carried out using the "Check syntax" button.

Array List

This region of the dialogue provides a list of arrays to be used in the calculation.    The radio buttons allow 
filtering of the list.    This filtering only affects the contents of the drop down list, it does not change any 
array names input to the function.    The array name can be automatically pasted into the function,    
(Paste Array)

X Values

In DynaTool there is no requirement for all of the arrays to use the same X or abscissa values.    For the 
calculation, the target array has to have an X value set, the X Values sub section allows different methods
of filling the X values.

Use All X Values the calculations will be carried out at all X values from all arrays used in the calculation. 
Take care as this can lead to very long target arrays, and it could also lead to adjacent X values which are
separated by very small intervals which may cause problems in using other functions.    The values in the 
X array are sorted into order, either ascending or descending, depending upon the ordering in the 
selected arrays.    If there is a conflict, then a dialogue is presented to resolve the conflict.

Use Target Array the calculation will be carried out using the X values present in the target array, if the 
target array already has X values.    If the target array does not have any X values, (a new array for 
instance), then the first array in the expression is used.    A warning is issued.

Use Array selecting this radio button activates the array list to allow an array to be selected to access its 
X value list.    This array does not have to be a part of the calculation.

When carrying out calculations, Y values are interpolated or extrapolated from the data in any array, 
therefore, it is not necessary for all arrays to have the same X values.    If the calculation contains 
response spectrum arrays, an option dialogue is presented to determine whether or not to use log/log 
interpolation on these arrays.

Functions

The functions drop down list allows pasting (Paste Function)of mathematical functions or pre-defined 
constants to the function window.    These functions act on the argument, which can be the Y values of a 
named array, or on a constant value or an expression.    (See syntax) 

The following functions are available: 

Abs(y) Takes the absolute value of the argument.



Acos(y) Returns the arc cosine of the argument in radians.
-1 < arg < 1

Asin(y) Returns the arc sine of the argument in radians.
-1 < arg < 1

Atan(y) Returns the arc tangent of the argument in radians.
Ave(y1, y2, ...) Returns the average of the arguments.    There is no limit 

to the number of arguments.
Cos(y) Returns the cosine of the argument which is assumed to 

be in radians.
Cosh(y) Returns the hyperbolic cosine of the argument.
exp(y) Returns e power of the argument.    Can also be entered 

as e^y
Int(y) Returns the integer value of the argument.
Ln(y) Returns the natural logarithm of the argument. Arg > 0
Log10(y) Returns the logarithm base 10 of the argument. Arg > 0
Max(y1, y2, ...) Returns the maximum of the arguments.    By mixing array

values and constants, clipping can be achieved.
Min(y1, y2, ...) Returns the minimum of the arguments.    By mixing array 

values and constants, clipping can be achieved.
Sin(y) Returns the sine of the argument which is assumed to be 

in radians.
Sinh(y) Returns the hyperbolic sine of the argument.
Sqrt(y) Returns the square root of the argument. Arg >= 0
Std(y1, y2, ...) Returns the standard deviation of the arguments.
Tan(y) Returns the tangent of the argument which is assumed to 

be in radians.
Tanh(y) Returns the hyperbolic tangent of the argument.
Var(y1, y2, ...) Returns the variance deviation of the arguments.

Pre defined constants

The following functions insert constant values to an expression.

AMaxVal(array) The absolute maximum Y value of an array.
AminVal(array) The absolute minimum Y value of an array.
e e = 2.718281828459
MaxVal(array) The maximum Y value of an array.
MinVal(array) The minimum Y value of an array.
Pi Pi = 3.14159265359
xmax The maximum X value of the target
xmin The minimum X value of the target
xval The current X value.    Not actually constant.
ValAt(array, x) The Y value from "array" at the value of X.    The firat 

argument must be an array, the second argument can be 
any number or pre-defined constant, ValAt(array, xmax) 
for instance.

Entering the Expression

The function can be entered into the Calculation edit box in several ways;

By using the keyboard, position the cursor in the box using the mouse.
By using the keypad in the Key Pad section of the dialogue.
By using the Paste Array button.    The array name selected from the drop down list is inserted at the 
current insert point.
By using the Paste Function button.    This button is only active when a function or pre-defined constant 



has been selected from the drop down list of functions.    The selected function is pasted into the 
calculation at the current insert point.    It may be necessary to manually insert data to the argument list for
the function.
It is not necessary to use the paste buttons to insert array names or functions, they can be entered from 
the keyboard.

The Undo Last button will undo the last edit.    The number of undos available is indicated by the number 
in the button.

Scan Old Calculations checkbox.    DynaTool stores the last eight calculations entered in the 
DynaTool.ini file in the windows home directory.    By checking this box, the first three buttons change 
function to allow scanning of the stored calculations.    The Next Calc button gets the next calculation 
from the list, the Prev Calc gets the previous calculation.    The list is treated as a cyclic list, cycling to the 
beginning once the end is reached and visa versa.    The Transfer button transfers the chosen function to 
the calculation edit box.    Once a calculation is transferred, the Scan Old Calculations check box will be 
un-checked.    If no calculation is transferred, (by unchecking the Scan Old Calculations check box), the 
original content of the edit box is restored.    A transferred calculation can be edited as normal.

Check Syntax

The check syntax button checks the syntax of the function at any time during entry of the function.    No 
calculation takes place.

The following syntax rules are defined for the calculation;

array_name = expression

where function is made up of array names and functions as described above.    The normal rules for 
mathematical functions apply, with the following operators:

^ raise to power
* multiply
/ divide
+ plus
- minus

When dividing, if the program detects a zero denominator it replaces it with a very small value, 1x10-12.    
Evidently, this may have a knock on effect, please take care.    No warning is issued.

() brackets are used to promote parts of the calculation.

Array Names
Array names MUST be quoted, e.g. "First floor E/W spectrum"

Functions and Pre-declared Constants
Functions can be entered in any case, the arguments must be enclosed in parentheses and separated by 
comma's.

Pre-defined constants can be entered in any mix of upper and lower case.    If a constant takes 
arguments, they must be enclosed in parentheses and separated by comma's.

Sub Expressions
The overall expression can contain sub-expressions, enclosed in parentheses.    The first token of an 
expression can be a minus sign, therefore, allowing the negating of array values. 

e.g. "array" = -"array"



There is no programmed limit to the nesting depth, it has been assumed that practical limits will prevail.

Overall Expression
There MUST be a target array to the left hand side and there MUST be an equals sign.    Array names to 
the right hand side of the equation MUST all exist.    If the array named to the left hand side does not 
exist, then it will be created.

The syntax checker is invoked when the OK button is pressed or by pressing the Check Syntax button.



Time History - Set-up
The time history set-up dialogue sets attributes for time history generation.    Changes made in this 
dialogue are stored in the DynaTool.ini file in the windows home directory, and remain in effect until 
changed.

Improve High Frequency Calculation
This feature is used in isolation from that set for response spectra.    It should be noted that this greatly 
slows calculation of response spectra and has a significant effect on time required to calculate a time 
history.

Frequency Content

These radio buttons control the frequency content of the generated time histories.    The Low option fits 
one frequency between the ASME recommended frequencies, Medium fits 3 between each frequency 
and High uses a function to insert a large number of frequencies.    The frequency content will affect the 
ability to match the response spectrum at frequencies other than the ASME/NUREG frequencies.    
Evidently, the more frequencies, the longer the calculation time.



Response Spectrum
The time history set-up dialogue sets attributes for time history generation.    Changes made in this 
dialogue are stored in the DynaTool.ini file in the windows home directory, and remain in effect until 
changed.

Improve High Frequency Calculation
This feature improves the calculation of the response spectrum at high frequencies by interpolating 
between time points on the time history.    The resolution factor is used to control the calculation, the 
higher the number, the better the fit, but also the longer the run time.



File Reading Formats
Files from which array data is to be read should be comma or space separated data.    Both comma and 
space separation can be used in the same file.    Data is read sequentially from the file, irrespective of 
column layout.    Each line is read left to right in turn.    If X and Y data is to be taken from the same file, 
then data is read X, Y, X, Y, X, Y ..... to the end of the file.



Toolbar command (View menu)
Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in DynaTool, such as File Open.    A check mark appears next to the menu item when the 
Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in DynaTool,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document.    DynaTool displays the Open dialogue box, in which you can locate 
and open the desired file.

Save the active document or template with its current name.    If you have not named the 
document, DynaTool displays the Save As dialogue box.    This button is only active if there is something 
to save or if the current data changes.

Print the active document.

Print preview.

Create a New Array

Fill Arrays - only active if there are arrays to fill.

Generate Time Histories - only active if response spectra exist. 

Generate Response Spectra - only active if time histories exist.

Array Calculus - integration and differentiation - only active if arrays exist.

Array Algebra - only active if arrays exist.



Status Bar command (View menu)
Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar (View menu)

The status bar is displayed at the bottom of the DynaTool window.    To display or hide the status bar, use 
the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description

MEM Kb Available system memory in Kbytes.

RES % Remaining system resources in %.

CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Define Plot (Plot menu)
Only active if filled arrays exist

Plot Name

Each plot is named to allow multiple plot definitions to be created.    Names should be unique.    If an 
existing name is selected from the list, then its contents are displayed for editing.

Define Plot

The define plot area displays in a list all existing arrays.    To add an array to the plot list, highlight, then 
use the Add button or double click the entry.    Multiple entries can be selected and added by using the 
<shift> and <control> keys with the left mouse button.    See Windows help for details.

To remove entries from the plot definition, highlight the array name(s) and use the Remove button, or 
double click.    Clear All removes all definitions from the plot list.

On exit, the plot will be displayed.

Plot definitions are saved to file with array data.    The plot being displayed when the file is saved is 
displayed when the file is re-opened.



View Plot (Plot menu)
Only active if plot definitions exist

Lists the named plot definitions to allow a different plot to be displayed.    Select the required plot from the 
list.    Double click the plot name, or us OK to exit and select.



Appearance
The plot->Appearence menu contains the following commands:

Axis ... Sets the attributes for the plot axes
Grid Lines … Sets the attributes for the major and minor grid lines
Titles … Sets the titles for the plot
Borders … Format the plot borders and text backgrounds
Lines … Format the plot lines

Show Attributes
The plot->Show Attributes menu contains the following command menus:

Titles Check mark menu to switch titles on/off
Axis Values Check mark menu to switch axis values on/off
Log Axes Check mark menu to switch between log and normal axes
Borders Check mark menu to switch borders on/off
Axis Attributes Check mark menu to modify axis display
Show Legend This check mark toggles the legend display on and off



Font
The plot->Font menu contains the following dialogues:

Main Title … Sets the font for the main title
Sub Title … Sets the font for the sub title
X Axis Title … Sets the font for the X axis title
Y Axis Title … Sets the font for the Y axis title
X Axis Values … Sets the font for the X axis values
Y Axis Values … Sets the font for the Y axis values
Legend Title … Sets the font for the legend title
Legend … Sets the font for the legend text

The standard Microsoft font selection dialogue is activated.



Axis Appearance
This dialogue formats the axis for the plot.    Some functions are available in other dialogues.

The following are repeated for the X and The Y axis.

Axis Type

Check this box for a log axis.    See also 

Automatic Range

The default is for the axes to be automatically scaled based upon the data to be plotted.    If the data 
changes, e.g. if an array is added to the plot definition or if the contents of an array are changed, the axes
will re-scale.

User Defined Scaling

Using this area of the dialogue, the axis scales can be set manually.

Axis Display

This area of the dialogue alters the display of the axes.    Check boxes for display.

Draw Axis.    See also
Switches the axis display on and off.

Tick Marks.    See also

Switches the display of tick marks on and off.    Tick marks cannot be displayed without the axis being 
displayed.

Plot At 0.

Forces the axis to be plotted at the O value, otherwise, it is the bottom or left of the plot.

Axis Colour

Allows the definition of the axis colour.

Line Thickness

Allows setting of axis line thickness.

Switch titles on/off
Switch axis values on/off



Plot Titles
This dialogue sets the text to be displayed as titles on the plot.    Displaying of titles is controlled by other 
dialogues.

The following titles can be defined: Main Title, Sub Title, X Axis Title, Y Axis Title, Legend Title.    
Formatting of titles and displaying of titles is controlled separately.



Plot Borders
This dialogue sets the border and background colours, and border line thicknesses.    The border being 
formatted is selected with the radio buttons to the left of the dialogue.    To the right, line thickness and 
colour is selected along with the line colour.

Chart border the border around the whole chart.    A chart cannot have a clear background.

Plot Border the border around the plot.    A plot cannot have a clear background.

Legend Box the border around the legend box.    If the background is set to clear it will be the same
colour as the chart background.

Legend Box Title titles cannot have borders, but they can have backgrounds.    If the background colour 
is clear, then the plot background is used.

Main Title
Sub Title
X Axis Title
Y Axis Title

Backgrounds are not available for the axis annotation.



Plot and Grid Lines
This dialogue sets line styles and colour for plotted lines.    The same dialogue is used for the plotting of 
data lines and for the plotting of grid lines.



Plot Titles Menu
Plot->Show Attributes->Titles

This check mark menu consists of a set of toggles which activate the showing of titles.    Five items 
activate/de-activate display of titles:
Main Title, Sub Title, X Axis Title, Y Axis Title

The All Titles option toggles all titles on/off.



Plot Axis Values
Plot->Show Attributes->Axis Values

This check mark menu consists of two toggles to switch the display of axis values on and off:
X Axis Values, Y Axis Values



Log Axes
Plot->Show Attributes->Log Axes

This check mark menu toggles between log and normal axes:
Log X Axis, Log Y Axis



Plot Borders
Plot->Show Attributes->Borders

This check mark menu toggles borders on/off:
Chart Border, Plot Border, Legend Border

The following check marks switch the text backgrounds on/off
Main Title, Sub Title, X Axis Title, Y Axis Title

The All Borders option toggles all borders on/off.



Axis Attributes
Plot->Show Attributes->Axis Attributes

This check mark menu toggles axis displays on/off:
Plot X Axis, Plot Y Axis, X Axis Ticks, Y Axis Ticks

Switching off the axis display, switches off the tick mark display.    Tick marks cannot be displayed without 
the axis being displayed.



New command (Window menu)
Use this command to open a new window with the same contents as the active window.    You can open 
multiple document windows to display different parts or views of a document at the same time.    If you 
change the contents in one window, all other windows containing the same document reflect those 
changes.    When you open a new window, it becomes the active window and is displayed on top of all 
other open windows.



Cascade command (Window menu)
Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)
Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)
Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)
Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command
Use this command to arrange the icons for minimised windows at the bottom of the main window.    If 
there is an open document window at the bottom of the main window, then some or all of the icons may 
not be visible because they will be underneath this document window.



1, 2, ... command (Window menu)
DynaTool displays a list of currently open document windows at the bottom of the Window menu.    A 
check mark appears in front of the document name of the active window.    Choose a document from this 
list to make its window active.    



DynaTool   Help (Help menu)  

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using DynaTool and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)
Use this command for instructions about using Help.



About command (Help menu)
Use this command to display the copyright notice and version number of your copy of DynaTool.



Print command (File menu)

Use this command to print a document.      This command presents a Print dialogue box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialogue box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialogue box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialogue

The Printing dialogue box is shown during the time that <<YourApp>> is sending output to 
the printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialogue box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialogue box, where you specify the printer and its connection.



Print Setup dialogue box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialogue box where you can make additional choices about printing, specific 
to the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



DynaTool Bugs and Failings
Bugs, DynaTool is perfect, but then the World is flat!

Well maybe there are some ...

At release 1.0.3 all known bugs have been removed.

Shortcomings

Response Spectrum Calculation
Response spectrum calculation is carried out on absolute values only.

Complex Numbers
The program only uses complex numbers internally whilst executing Fast Fourier Transforms.    It 
is intended to allow general access to complex numbers.

Memory Availability
The program displays an indication of the available system memory, but it does not always 
monitor failure to allocate new memory resources.    Traps need to be added, and these will go in 
as the program develops.    This should only be a problem when very large problems are being 
tackled.



DynaTool History
Version Date Release Description

v.1.0.2 July 1996 Pre-release restricted freeware version (beta test).
The following features are disabled for the freeware version:

Export files;
Printing;
Storage of mathematical functions.

The following features are disabled due to incomplete 
development:

Mathematical processing between arrays;
Printing, disabled for freeware, is not of a high 
enough quality for release;
List filling of arrays;
Storage of plot definitions.

The help file is definitely incomplete.

v.1.0.3 Dec 1996 Release version.

All of the above problems fixed except for list filling which has
been removed.

Calculator works correctly.

Plot formatting features added.

Time history seismic frequency range frequency content now 
optional.



DynaTool Release Notes
Version 1.0.2

This release of the program is a pre-release (beta version) of the freeware version.    There are 
functions which are incomplete, these have either been de-activated or they work to a certain 
point to allow their intent to be seen.

Useful functions, such as printing and ASCII file exporting of results have been purposely 
disabled.    The bulk of the program works to give a full idea of the program capability.

The original idea was to support seismic applications and some features are, therefore, biased.    
This will change, hopefully before the official release.

The program is modular, adding different processors is not too complex, therefore, ideas for 
further development will be accepted.

The capabilities for freeware, shareware and fully supported versions have yet to be worked 
out, as has the pricing structure.

Version 1.0.3

This release of the program is the first full release of the program.    Feature incomplete at the beta
release have been completed.    The user help file has been completed.    Plotting has been 
improves.    Plot formatting has been added.

Time histories can now be generated in frequency ranges other than the seismic range.



DynaTool Theory Manual
DynaTool has some theoretical basis, but what is it?



DynaTool Wish List
I wish, I wish ...

OLE connection to Excel etc.
Calculating of cross correlation coefficients.
Addition of ability to sample input from the RS232 and parallel ports.
Ability to restart time history calculation to improve quality.
General access to Complex numbers.
Smoothing of response spectra
Peak broadening of response spectra
Other transforms



DynaTool Verification Manual
DynaTool has undergone some verification, but in many ways it is self verifying.

This document will have verification tests added in time.



DynaTool - Time and Frequency Domain Tool Kit

1.0 Introdution
2.0 Structure
3.0 What Does   DynaTool   Provide?  
4.0 Why Use   DynaTool  



1.0 Introduction
DynaTool has been written to group together tools for the pre-processing and post processing of 
data from time and frequency domain analysis into a Microsoft Windows environment.    It was 
originally written to process data associated with seismic analysis, it is possible however that 
many routines will work adequately for other fields of study.    The program brings to the PC 
environment functions which to date have been the preserve of workstation and mini computer 
systems.    Used on a PC networked to a UNIX system, or by using data transfer, it will fit into the 
advanced engineering environment, and between the engineering and publication of results.

DynaTool has been written using the Microsoft Visual C++ which not only has the advantage of 
making the program compatible with MS Windows but it also means that the program is modular 
in nature thus allowing new analysis modules too be added at a later date.      The use of C++ also
allows the program to grab memory as it is required, thus the initial load module is not too large.

DynaTool contains functions to generate time histories with random phase angles, response 
spectra and Fourier transforms.    In addition, a powerful user programmable calculation module 
allows the comparison and manipulation of stored data.    Array data can be combined, averaged, 
enveloped, clipped, scaled and much more.

DynaTool is a developing product.



2.0 Structure

DynaTool has been structured to allow free definition of data storage, almost completely in the 
control of the user.    Data is stored in dynamically allocated arrays which themselves are stored in
classes.    Each array class contains the X and Y data, or the array can be defined internally by 
the program as a complex array, here the Y array is defined as an array of complex numbers with 
the X array real.    At the initial version of the program these arrays are used only for the Fourier 
transform from a real time domain series to the frequency domain.

The array classes are created as and when the user requires, they can also be deleted to release
memory.    In theory each array can be up to 64 Kbytes in size, since all real numbers are stored 
as double precision the theoretical maximum array size is 8096 entries.

Data is recovered from the arrays using interpolation and extrapolation schemes, so the program 
is not restricted to working on data at stored values.    This allows inter-operation between arrays 
and the creation of new data sets from multiple input sets from different sources.    When working 
with response spectrum data the interpolation is based on a logarithmic scheme.



3.0 What Does DynaTool Provide
DynaTool provides a collection of tools which are of use to engineers and scientists involved in 
seismic analysis.    The tools provided are based on those used for structural analysis, however, 
they are based on standard techniques and will be of use to other branches of time and 
frequency domain analysis.

· Time history from a response spectrum.    Suites of time histories from the same 
response spectrum including random seed for independence.    If a suite of 3 are 
requested this will be two horizontal and one vertical with the response spectrum 
amplitudes multiplied by 2/3.

· Response spectrum from time history using both equal time steps and unequal time 
steps.

· Fourier transform from time domain to frequency domain and back.
· Check statistical independence between groups of arrays.
· Carry out algebraic operations between arrays.    (Not matrix algebra.)

· Envelope arrays.
· Import data from text files.
· Export arrays as text files.
· Plot array data.
· Print and plot reports.



4.0 Why use DynaTool?
Why use DynaTool in place of spreadsheets and bespoke software?

DynaTool has been written to group functions together, many of which people    will have in their 
personal tool kit as individual isolated programs and spreadsheets.    DynaTool groups these into 
one package to ease the post processing of dynamic analysis data.    Since it has been designed 
to work with arrays only it is more efficient than a spreadsheet.    It will allow the arrays to be 
processed in many ways including creating new data by use of array algebra.    The resultant can 
be written for input into other programs such as Finite Element Analysis programs used in 
structural analysis.

Written with the processing of seismic data in mind, it is not necessarily true that this is the only 
type of data for which DynaTool will be of use.    The data is internally represented as vectors, 
therefore, the program will be of use to anyone processing such data forms.

DynaTool will develop over the years to include new capability.




